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VSClinical ACMG Trio Tutorial, Release 2.2.1

Updated: April 1st, 2020
Level: Intermediate
Product: VarSeq
This tutorial covers a basic VSClinical ACMG Trio workflow with an emphasis on understanding and exploring the
trio filter logic and VSClinical ACMG classification tools.
Requirements
To complete this tutorial you will need to download and unzip the following file, which includes sample trio data to
analyze in the project. This file is a multi-sample VCF file with Proband (NA12940), Mother (NA12938), and Father
(NA12939).
Important
The majority of the workflow described in this tutorial requires VarSeq with the VSClinical ACMG algorithm. You
can go to Discover VarSeq and request a viewer or evaluation license.
Download
VarSeq_VSClinical_ACMG_Trio_Tutorial.zip
Note: VarSeq version 2.2.1 was used to create this tutorial. While every attempt will be made to keep this content
relevant, it is possible that certain features or icons may change with newer releases.
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CHAPTER
ONE

SETUP

The most recent version of VarSeq can be downloaded from here: VarSeq Download.

Select your operating system and download. Additional information for platform specific installation can be found in
the Installing and Initializing section of the manual.
The Setup Wizard will then guide you through the setup process.
On the final page of the Setup Wizard, select Finish with the Launch VarSeq option checked.
This will bring up the introductory VarSeq page where new users can register their information. This will lead to a
confirmation email being sent to confirm the email address.
Once the email has been confirmed, users can select the Login tab and enter their login email and password.
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At this point, the VarSeq Viewer mode is accessed and can be used. If the user already has a license key, this can be
activated by selecting Help on the title bar and then selecting Activate a VarSeq License Key.

This will bring up a dialog where the license key can be entered. Enter you license key, select and select Verify.
Once the license key is verified, select the I accept the license agreement after reading the agreement, and select
Verify.
Congratulations! At this point, the product license is activated and you are ready to start an example project or a
tutorial!
Note: During the initial installation process, the user will be asked where to store the AppData folder. Although
this location can be changed after installation, it is recommended that multiple-user organizations select a shared drive
location to increase ease of project sharing and to decrease redundancy.
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CHAPTER
TWO

OVERVIEW

Trio Tutorial
This tutorial will cover a trio analysis that includes importing VCF files, annotating and filtering variants, and rendering
a clinical report using the ACMG Guidelines. The sample data includes a Yoruban trio from the HapMap Project with
Mother-NA12938, Father-NA12939, and Proband-NA12940. Using this pedigree structure we will identify variants
of different inheritance structures and evalute them using VSClinical according to the ACMG Guidelines.
VarSeq VSClinical ACMG
VSClinical is a tool that provides a simple way to leverage all the available evidence for a variant and score it for
the potential impact it has on a disorder. The available evidence can be categorized into groups which includes
considerations for gene function/phenotype association, variant segregation in a family, results of running variants
through prediction algorithms or their presence in databases, but also utilizing previous discoveries you yourself have
made for any variant.
This collection of evidence is then linked to 33 criteria that the user can efficiently assess in a streamlined effort.
These criteria are then aggregated to provide the basis for the final classifications of pathogenic, likely pathogenic,
uncertain significance, likely benign or benign. When considering the amount of available evidence and requirements
for eventually classifying variants, this process can become complex and difficult to master. Fortunately, VSClinical
is a solution to this complexity. VSClinical provides a means of simplifying not only the process of scoring and
classifying variants, but also provides a simple yet sophisticated means of presenting all evidence and criteria visually.

Figure 1-1: Pathogenic and benign classification scale.
This tutorial walks the user though a trio analysis workflow with focus on the ACMG guidelines starting with a
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template provided by Golden Helix and ending with a clinical report. We will first cover the import steps and explore
the filtering logic then we will use the ACMG Classifier to evaluate selected variants and render a clinical report. This
tutorial was accompanied by three VCF samples contained in a ZIP file, which you will need to download and extract
to a convenient location.
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CHAPTER
THREE

NEW PROJECT WORKFLOW

This tutorial begins by opening a new instance of VarSeq and selecting Create New Project. With the Homo sapiens
(Human), GRCh37 (hg19) (Feb 2009) Genome Assembly chosen, select the template called ACMG Guidelines Trio
Template and then for the Name enter ACMG Trio Tutorial. If desired, you can also change the directory in which
the project is stored by clicking on the Browse icon. The interface should look like Figure 2-1.

Figure 2-1: New project dialog.
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Selecting OK brings you to the next screen that directs the user to import variants. Select Add Files, navigate to the
location of the extracted ZIP file, and add select the ACMG Guidelines Trio Samples. Click Next.

Figure 2-2: Import variants wizard opening screen.
In the Import Variants of Family Samples dialog, you need to define sample relationships and affection status as
well as sex. For the proband (NA19240) you will need to define mother (NA12938) and father (NA12939) as well as
the Affection status. You can do this by clicking on the dropdown options under the Mother and Father columns
and selecting the appropriate samples. Affection status can be selected by clicking once on the box. The proband is
also a Female, which should be selected under the Sex column. Mother and father Sex should also be defined. The
dialog should look like Figure 2-3. Once the sample relationships are defined, you also have the option to associate
BAM files using the Associate BAM File icon. Although we do not have BAM files for this project, this feature
will automatically detect the BAM files if they have the same sample name and are located in the same directory or
sub-directory as the VCF files. Click Next.
In the last import dialog, leave the default options selected and select Finished. This will import the VCF files into
the project template.
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Figure 2-3: Defining family structure.

Figure 2-4: Leaving default paramters in import wizard.
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CHAPTER
FOUR

SELECTING ACMG CATALOGS

After the import process the user will be provided with a dialog titled VSClinical ACMG Options, which will be
used to define the assessment catalog. The assessment catalog for VSClinical saves finalized ACMG variant classifications and is used as an internal variant database to track variants across projects, including final interpretations and
evaluations. If the user already created an assessment catalog for VSClinical, you can choose it from the dropdown,
otherwise select Create Catalog.

Figure 3-1: Assessment catalog setup.
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For the assessment catalog, the user can define the Database Type. Selecting the different options will provide
descriptions into the different types of catalogs. For this tutorial, we will select the SQLite option. Next click Browse
and place the folder in a local directory and designate the file name to be ACMG Catalog, click Save. The following
dialog should look similar to Figure 3-2. Then click OK. The ACMG Catalog should then be detected in the main
interface. Leave all other options as default and select OK.

Figure 3-2: Selecting assessment catalog using the SQLite directory.
You will then be prompted with an interface titled Internal Database of Classified ACMG Variants. For this option,
open the drop down and select the created ACMG Catalog. This will then finish importing the variants into the project
template and load the required annotations in the variant table.
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Figure 3-3: Internal Database of Classified Germline ACMG Variants.
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CHAPTER
FIVE

INVESTIGATING FILTER CHAINS

The VCF data imported into the project using the ACMG Trio Template resulted in 50,691 variants, which are applied
to the filter chain for variant quality control (Variant QC) and then the Inheritance Model. The inheritance model
includes: Dominant de Novo, Dominant Inherited, Recessive Homozygous, Ressessive Compound Heterozygous,
X-Linked, and Pathogenic in Incidental Finding (IF) Genes.For this project we will focus on variants present in the
proband but if we wanted to change the sample you can click on the dropdown icon, highlighted in Figure 4-1, to view
the other samples.

Figure 4-1: Trio workflow interface.
Lets take a look at the first filter container titled Variant QC. The Variant QC filter logic can be expanded by clicking
the square box icon in the upper right corner of the filter logic. All 50,691 variants are applied to this filter card which
includes filtering on Read Depth (DP) >10 and Genotype Qualities (GQ) >20. These fields are derived from the
sample field from the variant table. To add a field, right click on the column header and select Add to Filter Chain.
You can also delete filter cards by right clicking on the filter card in the filter chain and selecting Delete. Using this
filter logic resulted in a total of 48,521 variants, which are then passed into the Inheritance Model filter container.
Next, we will deep dive into the first inheritance filter container, variants of Dominant de Novo inheritance. For easier
viewing, minimize the Variant QC filter container, using the minimize icon, highlighted in Figure 4-2.
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Figure 4-2: Variant quality control filter.
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CHAPTER
SIX

DOMINANT DE NOVO

Looking at the inheritance model container, the first filter logic is variants of Dominant de Novo inheritance. The
Dominant de Novo filter logic is based on the Mendel Error, Gene Inheritance and the ACMG Auto Classification.
The Mendel Error algorithm computes the Mendel Error status, i.e. Mendelian inheritance, for the child’s genotype
and for this inheritance pattern, de Novo allele is selected. This filter indicates that the child’s genotype shows 152 de
Novo mutations that are not present in either parent. This can also be understood by looking at the genotype zygosity
for the proband, mother and father in the variant table. The proband has heterozygous calls whereas the parents are
either homozygous-reference or missing.

Figure 5-1: Dominant de Novo zygosity in variant table.
The next filter card criteria is Gene Inheritance, which Dominant is selected. This filter logic is pulled from the
ACMG Sample Classifier but is based on the known gene inheritance from OMIM, a licensed annotation. OMIM
is an annotation that is already integrated into the project but if absent can be added by going to File>Add>Variant
Annotation>Secure Annotations>OMIM. This filter results in 6 variants where the Gene Inheritance is Dominant.
The last filter logic applied is the Auto Classification from the ACMG Sample Classifier, which utilizes the available
variant evidence and scores it according to the ACMG guideline criteria. Together, this filter logic identified one
Pathogenic de Novo mutation with a Dominant inheritance pattern.At the bottom of the Dominant de Novo filter
container, clicking on the 1 in the filter logic will display the variant that has passed the filtering restrictions for this
inheritance pattern in the variant table.
We can also visualize the genotype call in Genome Browse. To do this open the Genome Browse tab and click on the
individual variant in your variant table and it will be displayed in the Genome Browse view. In Genome Browse you
can see it is a heterozygous variant in the proband but missing in the mother and father.
Next, we will take a look at the Dominant Inherited filter logic.
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Figure 5-2: Inheritance filter container.

Figure 5-3: Visualizing genotype calls in Genome Browse.
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CHAPTER
SEVEN

DOMINANT INHERITED

If you click on the 4 at the bottom of the Dominant Inherited filter container, it will display those variants that have
passed the filter restrictions for this inheritance pattern in the variant table.

Figure 6-1: Dominant inherited filter logic.
The Dominant Inherited filter logic is based on Mendel Error, Zygosity of the parents and proband, Gene Inheritance, and the Auto Classification from the ACMG Sample Classifier. The unique filter card that is used for this
chain was created based on output from our Genotype Zygosity algorithm. Genotype Zygosity is already in the
samples field of the variant table but if absent can be found under the Add>Computed Data>Genotype Zygosity. If
you expand the Either Parent is Heterozygous card, it will show you a more detailed filter logic. Specifically, this
card is filtering for variants that are heterozygous in the father and reference or missing in the mother, or heterozygous
in the mother and reference or missing in the father.
The next filter card identifies transmitted variants that are heterozygous for the proband (Current) as well as Dominant
for the gene inheritance pattern. The gene inheritance pattern comes from the ACMG samples classifier but is based
on the gene inheritance according to OMIM. Furthermore, Likely Pathogenic, Pathogenic or VUS/Weak Pathogenic
Variants from the ACMG Auto Classification are selected. Together this filter logic identified 4 variants that were
transferred from either the mother or the father to the proband. You can also click on these dominant inherited variants
in the variant table and open Genome Browse to visualize which parent transferred the variant to the proband. For
example, if you click on the row that contains the T/C variant at chromosome and position 7:151935853, you will see
in Genome Browse that the allele is inherited from the father. Once finished viewing, reopen the Filter Variant tab to
investigate the next filter logic: Recessive Homozygous variants.
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Figure 6-2: Variants present in the mother or father that are reference or missing in the spouse.
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Figure 6-3: Genome Browse view of dominant iherited variants.
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CHAPTER
EIGHT

RECESSIVE HOMOZYGOUS

The next filter logic identifies Recessive Homozygous mutations. A recessive homozygous mutation occurs when
there are two copies of the same recessive allele in the proband. This means that both parents are heterozygous for
a recessive mutation and the proband is homozygous, carrying both copies. Similar to the Dominant Inherited, this
filter logic integrates Genotype Zygosity. This can be visualized by expanding the Recessive Inheritance filter card,
which filters for heterozygous variants in mother and father and homozygous variants in the proband.
The next filter logic, Gene Inheritance, is pulled from the ACMG Sample Classifier but is based on the gene inheritance from OMIM. The two options that are selected are Default (Recessive) and Recessive. Default (Recessive) is
for a gene where the inheritance has not been identified as recessive or dominant, whereas the Recessive option is for
a gene known to be recessive. You can also see that there are 32 variants that have a Gene Inheritance of Missing.
These variants likely lack genotype zygosity, are reference alleles, or are not in a known gene. Together with the
Auto Classification, there are 4 variants identified as Recessive Homozygous, which can be selected and viewed in
the variant table and in Genome Browse.
At this point, we will now take a look at Recessive Compound Heterozygous mutations.
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Figure 7-1: Recessive homozygous inheritance.
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Figure 7-2: Gene Inheritance for Recessive Homozygous variants.
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CHAPTER
NINE

RECESSIVE COMPOUND HETEROZYGOUS

A compound heterozygous polymorphism refers to a child that has inherited two different heterozygous polymorphisms within the same gene, one from each parent. This could result in both copies of the gene being potentially affected. This type of polymorphism should also alter the amino acid sequence, or be classified as a nonsynonymous variant. The unique filter card implements the Compound Het algorithm, which can be found by going
to Add>Computed Data>Compound Het. It is important to note that this algorithm is computed on the variants in
the selected filter chain and not all variants orginally imported.

Figure 8-1: The compound het algorithm determines inheritance of two different heterozygous polymorphisms within
the same gene.
Using the Auto Classification, Compound Het algorithm and Gene Inheritance filter logic identified 16 variants. To
see further specifics, click on the Compound Het Genes table, next to the variant table tab. In the left dialog you can
see the Gene Names and if the gene has a compound het polymorphism, as well as the variant information in the right
dialog. If you click on a gene in the Gene Name column, the variant table will display the variants that fall within that
gene. For example, if you click on the Gene Name: ANKRD36, you can see that this gene has three variants, one De
novo variant and two heterozygous mutatons inherited from the mother. Once finished, change the display back to the
Variant table tab, Variants: 16.
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Figure 8-2: Opening the Compound Het Gene table displays affected genes and associated variants.
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CHAPTER
TEN

X-LINKED

X-linked mutations occur in sex chromosomes or non-autosomal regions. The first filter segments the X-chromosome
into specific regions to rule out pseudo-autosomal regions (PAR). PAR regions are homologous sequences of nucleotides on the X and Y chromosomes and any genes within them are inherited just like any autosomal genes. The
next filter logic that is applied is the zygosity, which selects for hemizygous (only one copy of a gene is present) and
homozygous mutations. When the Auto Classification is applied, however, there are 0 variants that are potentially
pathogenic in the X chromosome.

Figure 9-1: X-linked filter logic segments the chromosome to filter our pseudo-autosomal regions.
Next, take a look at Pathogenic in IF Genes.
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CHAPTER
ELEVEN

PATHOGENIC IN IF GENES

The Pathogenic in Incidental Finding (IF) Genes filter card is based on the ACMG recommendations for mutations
in certain genes that should be reported to individuals because of their high potential medical importance. There are
currently 59 ACMG IF genes that are accessed through this link, https://www.ncbi.nlm.nih.gov/clinvar/docs/acmg/,
and the list can be seen by selecting the details icon and clicking on the column in your variant table titled In ACMG
IF Genes?. There are two variants that applied to this filter logic, one in the SMAD4 gene and the other in DSPP.

Figure 10-1: Show column details functionalilty.
Now that we have explored the filter logic for a trio workflow, lets now focus on using VSClinical to evaluate variants
according to the ACMG guidelines.
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CHAPTER
TWELVE

ACMG GUIDELINES

To open VSClinical select the ACMG Guidelines tab and for viewing purposes lets hide the variant table by hovering
over the bottom right corner of the variant table and selecting the icon that will appear. Select it and it will stash the
variant table view.

Figure 11-1: Opening VSClincical and stashing variant table view.
At this point the ACMG Guidelines tab is ready to start an evaluation. This requires selecting variants to evaluate
by adding them to the To Evaluate variant set. There are two ways to do this selection: from the Variant Table or
the Variants to Evaluate section in the current ACMG Guidelines tab. We will proceed by selecting the SMAD4
p.I500V Pathogenic variant in the VSClinical interface. Optionally you could select more variants but we will focus
on one variant for this analysis. Once selected it should appear in the To Evaluate section as shown in Figure 112. Next, select Start New Evaluation at the bottom of the VSClinical interface and then select Continue after the
algorithm queries whether the selected variant has been previously classified in your assesment catalog.
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Figure 11-2: Selecting variants to evaluate.
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CHAPTER
THIRTEEN

VSCLINICAL

The ACMG Guidelines tab will open the main Classifications page in the center and the variant information in the
sidebar.

Figure 12-1: The ACMG Guidelines evaluation screen.
The collapsible right sidebar can be used to switch the evaluation to other variants as well as see summary information
about the current variant. Although only one variant was pulled into this evaluation, each variant is represented with
a box with the variant names available on hover. The boxes are filled in when the variant is evaluated and saved. The
color scheme is as follows.

Figure 12-2: ACMG Guidelines pathogenicity color scheme .
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Each variant is automatically evaluated by the ACMG recommendation engine, with many of the individual criteria
receiving recommendations on whether it should be answered Yes or No as well as detailed reasons for these recommendations.
In the Evidence Summary section, criteria that are recommended will be listed under Recommended to Score
Pathogenic and Recommended to Score Benign. The name of the recommended criteria are in colored bubbles with
arrow links to navigate to the tab and section containing the criteria question and supporting evidence.
Criteria questions are organized in the following tabs located at the top of the interface: Population, Gene Impact,
Studies, and Clinical. In the following pages of this tutorial, we will go through the tabs to evaluate the SMAD4
variant that will take us through these tabs. As we answer criteria questions, note how the right bar ACMG Scoring
section will update with the currently scored criteria and the resulting ACMG Classification.
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Figure 12-3: ACMG Classification side bar.
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CHAPTER
FOURTEEN

SMAD4 P.I500V FREQUENCY

The example variant we will be evaluating using the ACMG guidelines is a missense mutation in the SMAD4 gene.
You will see red notifications across the top interface of VSClinical, which indicate that there are critical criteria to
evaluate. The first tab we will investigate will be the frequency of this mutation in the Population tab. Navigate to the
Population tab by selecting it.

Figure 13-1: Population tab.
In the Population tab you can then expand the dropdowns including Tolerated Frequency, gnomAD Exomes Frequency and 1000 Genomes Frequency. The Tolerate Frequency will display the Gene/Disorder Inheritance model
as well as the threshold frequencies implemented in gnomAD and 1000 Genomes. For this SMAD4 gene the inheritance model is identified as Dominant. It is also worth mentioning that as of the 2015 publication on the original
ACMG Guidelines, the default frequency threshold for BA1 is 5% but Golden Helix implemented the more clinically
accepted 1% threshold. These details are integrated into the documentation for the criteria, which can be accessed by
selecting See further discussion on PM2 in the Show Details section for BA1.
Next, we can investigate the frequency in gnomAD and 1000 Genomes and both databases will display the highest
frequency among individual subpopulations. Although this variant is observed in 1 of 113,754 (0.0009%) individuals
in European (Non-Finnish) populations according to gnomAD, it is considered novel in 1000 Genomes. With a low or
absent frequency in the population catalogs, we can answer the YES to the first relevant scoring criteria PM2, which
states if the variant is: Absent from controls in population catalogs. Notice once yes has been selected, it will add it to
the ACMG Scoring model on the right side.
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Figure 13-2: Tolerated frequency.

Figure 13-3: ACMG criteria PM2.
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CHAPTER
FIFTEEN

SMAD4 P.I500V GENE IMPACT

The next tab we will investigate is the Gene Impact tab. In this tab the first dropdown is Gene and Transcript,
which provides the user with relevant information including the Gene Name, NCBI description as well as the ability to
change the transcript. By clicking on the blue transcript icon, you can then change the default transcript by selecting
a different transcripts if available, which will be stored throughout the evaluation as well as if you see this gene in a
future sample. The default transcript selected is based on clinical relevance and other heuristics, that are outlined in
this blog: https://blog.goldenhelix.com/whats-in-a-name-the-intricacies-of-identifying-variants/. For this gene there is
only one transcript, so click Close.

Figure 14-1: Opening the Gene Transcript tab.
The next dropdown to investigate is the Gene Region and Mutation Profile, which provides previous counts of
variants in ClinVar as well as those present in your internal catalog. For this interface you can change the settings to
look at Missense mutations that occur within the same Exon that have been classified as Pathogenic. You can see that
there are 3 variants located within 6 amino acid positions of the SMAD4 p.I500V variant and the region contains no
benign variants. With this evidence, we can apply PM1 to the evaluation by selecting Hot Spot and No benigns.
To determine the missense mutation rate for the SMAD4 gene, we can then focus on the next drop down, Missense as
Mechanism of Disease. For this gene, the Z-score produced by the Exome Aggregation Consortium (EXAC) is high,
4.18, which indicates that there is a low rate of bening missense variants in this gene and that there are other missense
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Figure 14-2: Applying PM1 in the Gene Region and Mutation Profile.
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variants that provide a common mechanism for disease. Together, this provides the first supporting evidence criteria,
PP2.

Figure 14-3: Z-score from EXAC.
Moving on to the Computational Evidence section, we can see the conservation and functional prediction algorithms
such as: SIFT, PolyPhen2, PhyloP and GERP++. These algorithms indicate that the variant is predicted to be damaging
(SIFT and PolyPhen) and occur in a conserved region (PhyloP and GERP), which applies PP3. PP3 states that multiple
lines of computational evidence support a deleterious effect on the gene or gene product. Answering All Deleterious
brings our current classification for the SMAD4 p.I500V to a Likely Pathogenic classification. This completes the
Gene Impact tab, so we will move on to the Studies tab.
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Figure 14-4: ACMG supporting criteria PP3.
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CHAPTER
SIXTEEN

SMAD4 P.I500V STUDIES AND CLINICAL SECTION

The Studies tab of VSClinical allows users to search for relevant literature regarding the variant. Specifically, in the
Clinical and Functional Studies section, this variant can be searched in Google, Google Scholar or PubMed from their
corresponding links. Additionally, the detailed assessments and citations of labs submitting this variant to ClinVar can
be reviewed. There are 14 ClinVar assessments for this variant, which show the source of interpretation, the guidelines
used and a summary that can be added to the evaluation. As an example, add the interpretation from GeneDx into
the Summary section of Clinical and Functional Studies by copy and pasting, or by hovering over the blue plus
icon and selecting Add Text to My Clinical Summary. Next, under Reported Variant(s) Amino Acid Change,
select Same Change (I500V) and Same Residue I500. Under the Observed State and Number of Probands, select
de Novo. Then under the Disorder or Clinical Description, select Myhre Syndrome. With the available literature
being referenced, you can then answer Yes to both PS1 and PM5, which brings the final predicted classification to
Pathogenic. After answering these criteria, click on the Clinical tab, to investigate the last criteria.

Figure 15-1: Clinical studies tab for literature referencing.
In the Clinical section there are scoring criteria that can be applied when there is known family history of the disorder.
For this patient, we know that the variant of interest is a de novo variant but we do not have evidence that both parental
samples, through identity testing, are the biological parents. Even though the parents have not been tested to be the
biological parents, we have the option to assume that they are. With this eveidence, we will answer Yes to De novo
variant and the patient has the disorder but no family history and Unconfirmed (Asumed) to Maternity and
51

VSClinical ACMG Trio Tutorial, Release 2.2.1

paternity confirmed, which applies the scoring criteria PM6. Since we have now answered all relevant criteria, let’s
go back to the main Classificaiton tab.

Figure 15-2: Applying PM6 in the Clinical tab.
At this point all of the criteria have been accounted for, the interpretation built and the final classification presented,
which is Pathogenic following rule iii of the ACMG guidelines: 1 strong, AND 3 moderate and 2 supporting criteria.
In summary, this has been determined to be a straight-forward Pathogenic variant, so we want to include this in the
final report, and specifically in the primary findings. To do this, scroll to the Interpretation section at the bottom
of the Classification tab. Under the Interpretation section, select the Primary Findings check box and verify that
Pathogenic is selected in the Classification drop-down menu. In the For Disorder: box, selecting the option will
provide a list of associated phenotypes based on the OMIM annotation source. Select Myhre Syndrome, and we
will leave the Inheritance/Variant Type as default. Lastly, we will add the interpretation created from the evaluation
using the Auto Interpretation on the right side. From the Auto Interpretation scroll down and select Add to
Interpretation, which will populate in the Interpretation section.
Once the information has been filled in, the variant interpretation can be saved by selecting Save>Save & Finalize
Samples>Finalize. If there were other variants pulled into the evaluation, the user could select Save and Next Variant
to complete the evaluation and interpretation process for the other variants. However, for this project we will now
demonstrate how to render a clinical report using our saved variant interpretation.
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Figure 15-3: The ACMG Classification Summary Panel.

Figure 15-4: Populating the variant interpretation.
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CHAPTER
SEVENTEEN

USING INTERPRETATIONS IN REPORTS

First open up the report tab by clicking on a new tab icon and selecting Report.

Figure 16-1: Opening the report tab.
We want to use the report template that is specific to the ACMG guidelines, so select the plus icon next to the template
name dropdown menu to add a new template. From the dialog that appears, select VSClinical ACMG Gene Panel
Template and type in: VSClinical ACMG Trio Template. Click OK.
Next, we will associate the assessment catalog used in VSClinical to the report to integrate the final classification and
interpretations. To do this, select the gear icon in the upper right-hand corner of the report tab and select Configure
Report Template from the dropdown. This opens the dialog that can be used to customize template entries regarding
lab information, but at the moment we want to use this to select the assessment catalog used by the report from the
dropdown menu in the ACMG Variants Catalog: field. Select ACMG Catalog then click OK.
This will return you to the main report tab. For the report, the first three sections of this template all involve
patient information which can be customized (see the advanced tutorial on Reports: VarSeq Reports Tutorial,
https://doc.goldenhelix.com/VarSeq/tutorials/varseq_reports/index.html), but we are going to scroll down to the Primary Findings section to populate the results from the variant assessment. From the Primary Findings dropdown,
select Primary Findings.
This will pull the variants from the Primary Findings set into this section. In this example we have the SMAD4
variant. The other fields in this report can be populated from the corresponding information that was saved to the
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Figure 16-2: Selecting the report template.

Figure 16-3: Adding assessment catalog to report template.

Figure 16-4: Matching the variant set to the report section.
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assessment catalog by selecting the Lookup button next to the Catalog Lookup. This will populate the variant entry
for the SMAD4 variant with the information saved in the assessment catalog.

Figure 16-5: Populating the variant entry with Interpretation Lookup.
Now that we have all of the information for this report, we can render it by selecting the Create the Report icon at
the top of this report tab.
This will then pull up the hidden table containing your Variant table, Compound Het Genes, Samples, as well as a tab
titled NA19240 Report, open this tab. This tab contains the final report, which can be opened in an external browser,
printed or saved as a PDF document using the export icon in the upper right corner of the report tab.
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Figure 16-6: The populated entry and render button.
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Figure 16-7: The final rendered report.
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CHAPTER
EIGHTEEN

CONCLUSION

That concludes the VarSeq VSClinical ACMG Guidelines workflow tutorial.
This tutorial was designed to give a taste of all the features and capabilities of VarSeq and a brief orientation to key
features. If you would like to learn more about the unique capabilities and functionalities of our software, we have
great webinars that can be accessed using this link: https://www.goldenhelix.com/resources/webcasts/index.html.
If you are interested in getting a demo license to try out additional features that require an active license, such as
creating a project, adding annotation sources, and saving project, please request a demo from: Discover VarSeq
If you have an active license, we encourage you to try out the intermediate tutorial on Cancer Gene Panels: Cancer
Gene Panel Tutorial
Additional features and capabilities are being added all the time, so if you do not see a feature you need for your
workflows please do not hesitate to let us know!
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